
  T R A I N S P O T T E R  U S E R  G U I D E  

    

- 1 - 

Trainspotter 1.54 User Guide 



  T R A I N S P O T T E R  U S E R  G U I D E  

    

- 2 - 

Contents 
1 INSTALLING TRAINSPOTTER ........................................................................................................................................................................................... 7 

1.1 WINDOWS........................................................................................................................................................................................................................... 7 
1.1.1 Prerequisites ................................................................................................................................................................................................................. 7 
1.1.2 Install steps ................................................................................................................................................................................................................... 7 

1.2 OS X ................................................................................................................................................................................................................................ 12 
1.2.1 Prerequisites ............................................................................................................................................................................................................... 12 
1.2.2 Install Steps................................................................................................................................................................................................................. 12 

2 RUNNING TRAINSPOTTER FOR THE FIRST TIME .................................................................................................................................................... 18 

3 THE TRAINSPOTTER USER INTERFACE ...................................................................................................................................................................... 21 

3.1 THE TOOLBAR .................................................................................................................................................................................................................. 21 
3.1.1 Search Mode ............................................................................................................................................................................................................... 21 
3.1.2 Tag Mode .................................................................................................................................................................................................................... 21 
3.1.3 Playlist mode .............................................................................................................................................................................................................. 21 
3.1.4 Group By..................................................................................................................................................................................................................... 21 
3.1.5 Left/right Arrows ........................................................................................................................................................................................................ 22 

3.2 THE MAIN MENU.............................................................................................................................................................................................................. 22 
3.2.1 File Menu .................................................................................................................................................................................................................... 22 
3.2.2 Edit Menu.................................................................................................................................................................................................................... 22 
3.2.3 Tools Menu ................................................................................................................................................................................................................. 22 
3.2.4 Help Menu .................................................................................................................................................................................................................. 23 

3.3 THE COLLECTION TAB ...................................................................................................................................................................................................... 25 
3.3.1 Data display ................................................................................................................................................................................................................ 25 
3.3.2 Hotkeys ....................................................................................................................................................................................................................... 27 
3.3.3 Context Menu .............................................................................................................................................................................................................. 27 
3.3.4 Drag and Drop ........................................................................................................................................................................................................... 28 

3.4 DISCOGS BROWSER TAB................................................................................................................................................................................................... 29 
3.4.1 Search Results ............................................................................................................................................................................................................. 29 
3.4.2 Hotkeys ....................................................................................................................................................................................................................... 30 
3.4.3 Search Update from Discogs ...................................................................................................................................................................................... 30 

3.5 CUSTOM TAGGING TAB .................................................................................................................................................................................................... 32 
3.5.1 Custom Tags ............................................................................................................................................................................................................... 33 
3.5.2 Standard Tags ............................................................................................................................................................................................................. 33 
3.5.3 Cover .......................................................................................................................................................................................................................... 33 



  T R A I N S P O T T E R  U S E R  G U I D E  

    

- 3 - 

3.5.4 Hotkeys ....................................................................................................................................................................................................................... 34 
3.6 PLAYLISTS TAB ................................................................................................................................................................................................................ 35 

3.6.1 Playlists Tree .............................................................................................................................................................................................................. 35 
3.6.2 Playlist Viewer ............................................................................................................................................................................................................ 38 

3.7 BATCH PROCESSING TABS................................................................................................................................................................................................. 39 

4 USING TRAINSPOTTER...................................................................................................................................................................................................... 41 

4.1 TAGGING YOUR TRAKTOR COLLECTION FROM DISCOGS .................................................................................................................................................. 41 
4.1.1 Searching for a matching release ............................................................................................................................................................................... 41 
4.1.2 Selecting a matching release ...................................................................................................................................................................................... 41 
4.1.3 Updating your Traktor collection ............................................................................................................................................................................... 42 
4.1.4 How Trainspotter Handles Cover Art ......................................................................................................................................................................... 42 

4.2 RECORDING TRACKS......................................................................................................................................................................................................... 42 
4.2.1 Prerequisites ............................................................................................................................................................................................................... 42 
4.2.2 Selecting a track to record .......................................................................................................................................................................................... 43 

4.3 RIPPING TRACKS ............................................................................................................................................................................................................... 43 
4.3.1 Prerequisites ............................................................................................................................................................................................................... 43 
4.3.2 Ripping a release ........................................................................................................................................................................................................ 43 

4.4 ENCODING TRACKS TO FLAC AND MP3 .......................................................................................................................................................................... 44 
4.4.1 Why? ........................................................................................................................................................................................................................... 44 
4.4.2 Prerequisites ............................................................................................................................................................................................................... 44 
4.4.3 Starting and Stopping encoding .................................................................................................................................................................................. 44 

4.5 APPLYING CUSTOM TAGS TO TRACKS ............................................................................................................................................................................... 45 
4.5.1 Why? ........................................................................................................................................................................................................................... 45 

4.6 CREATING DYNAMIC PLAYLISTS ...................................................................................................................................................................................... 46 
4.6.1 Why? ........................................................................................................................................................................................................................... 46 
4.6.2 Using Dynamic Playlists ............................................................................................................................................................................................. 46 

4.7 DETECTING KEYS ............................................................................................................................................................................................................. 46 
4.7.1 Why ............................................................................................................................................................................................................................. 46 
4.7.2 Using Key Detection ................................................................................................................................................................................................... 46 

5 PREFERENCES REFERENCE ............................................................................................................................................................................................ 48 

5.1 FILE .................................................................................................................................................................................................................................. 48 
5.1.1 My collection.nml file ................................................................................................................................................................................................. 48 
5.1.2 Periodically save a backup of your collection after updates have been performed .................................................................................................... 48 
5.1.3 My collection.nml backup directory............................................................................................................................................................................ 48 
5.1.4 Default file open directory .......................................................................................................................................................................................... 48 



  T R A I N S P O T T E R  U S E R  G U I D E  

    

- 4 - 

5.1.5 Maximum number of images to store per track .......................................................................................................................................................... 48 
5.1.6 Update folder album art ............................................................................................................................................................................................. 48 
5.1.7 Update embedded art in mp3 and flac files ................................................................................................................................................................ 49 
5.1.8 Apply album art to all tracks in release ...................................................................................................................................................................... 49 
5.1.9 Field to use store image paths .................................................................................................................................................................................... 49 
5.1.10 Fields to update...................................................................................................................................................................................................... 49 
5.1.11 Update Mix Fields from History ............................................................................................................................................................................ 50 
5.1.12 Check for Trainspotter Updates on Startup ........................................................................................................................................................... 50 

5.2 TRACK IMPORT ................................................................................................................................................................................................................. 50 
5.2.1 Folder Structure.......................................................................................................................................................................................................... 50 
5.2.2 File Naming ................................................................................................................................................................................................................ 51 
5.2.3 Preferred Separator .................................................................................................................................................................................................... 51 

5.3 LOOK AND FEEL ............................................................................................................................................................................................................... 51 
5.3.1 Window width ............................................................................................................................................................................................................. 51 
5.3.2 Window height ............................................................................................................................................................................................................ 52 
5.3.3 Open window maximized ............................................................................................................................................................................................ 52 
5.3.4 Run on top ................................................................................................................................................................................................................... 52 
5.3.5 Default grouping column ............................................................................................................................................................................................ 52 
5.3.6 Show the following fields in your collection ............................................................................................................................................................... 52 
5.3.7 Height of rows in collection browser .......................................................................................................................................................................... 52 
5.3.8 Display embedded cover art in collection browser..................................................................................................................................................... 52 
5.3.9 Maximum number of cover art images to cache ......................................................................................................................................................... 52 
5.3.10 Key Colours ........................................................................................................................................................................................................... 53 

5.4 SEARCHING ...................................................................................................................................................................................................................... 53 
5.4.1 Maximum number of search results to retrieve from Discogs .................................................................................................................................... 53 
5.4.2 Add recorded/updated tracks to discogs collection .................................................................................................................................................... 53 
5.4.3 Match filenames to regular expression ....................................................................................................................................................................... 53 
5.4.4 The regular expression group to use for (artist/catalog number/track/label) ............................................................................................................ 53 
5.4.5 Maximum number of characters that can be different before two track names are considered different ................................................................... 54 
5.4.6 Additional Google image search parameters ............................................................................................................................................................. 55 

5.5 RECORDING ...................................................................................................................................................................................................................... 55 
5.5.1 Recordings directory................................................................................................................................................................................................... 55 
5.5.2 Filename format.......................................................................................................................................................................................................... 56 
5.5.3 Recorded audio format ............................................................................................................................................................................................... 56 
5.5.4 Audio file editor command .......................................................................................................................................................................................... 56 
5.5.5 Rip Command ............................................................................................................................................................................................................. 56 
5.5.6 Parameters to Rip Command ...................................................................................................................................................................................... 56 



  T R A I N S P O T T E R  U S E R  G U I D E  

    

- 5 - 

5.5.7 Rip command outputs to standard error ..................................................................................................................................................................... 56 
5.6 ENCODING ........................................................................................................................................................................................................................ 57 

5.6.1 Path to FLAC encoder ................................................................................................................................................................................................ 57 
5.6.2 FLAC arguments ......................................................................................................................................................................................................... 57 
5.6.3 FLAC output directory ................................................................................................................................................................................................ 57 
5.6.4 Path to LAME encoder ............................................................................................................................................................................................... 57 
5.6.5 LAME arguments ........................................................................................................................................................................................................ 57 
5.6.6 LAME output directory ............................................................................................................................................................................................... 57 
5.6.7 Continue processing when error occurs ..................................................................................................................................................................... 57 

5.7 KEY DETECTION ............................................................................................................................................................................................................... 58 
5.7.1 Key Labels .................................................................................................................................................................................................................. 58 
5.7.2 Overwrite Existing Key Values ................................................................................................................................................................................... 58 
5.7.3 Perform key detection as part of encoding tracks to MP3/FLAC ............................................................................................................................... 58 
5.7.4 Perform key detection after ripping tracks from CD .................................................................................................................................................. 58 
5.7.5 Path to LAME MP3 encoder ....................................................................................................................................................................................... 58 
5.7.6 Path to FLAC encoder ................................................................................................................................................................................................ 58 
5.7.7 Temporary directory to use for decoded MP3/flac files ............................................................................................................................................. 58 
5.7.8 Path to audio decoder ................................................................................................................................................................................................. 59 
5.7.9 Arguments to audio decoder ....................................................................................................................................................................................... 59 
5.7.10 Extension to apply audio decoder to ...................................................................................................................................................................... 59 

5.8 CUSTOM TAG CONFIGURATION ......................................................................................................................................................................................... 59 
5.8.1 Type ............................................................................................................................................................................................................................ 59 
5.8.2 Name ........................................................................................................................................................................................................................... 59 
5.8.3 Values ......................................................................................................................................................................................................................... 59 
5.8.4 Automatically play track when tagging ...................................................................................................................................................................... 59 

5.9 COLOURS .......................................................................................................................................................................................................................... 59 
5.10 SCRIPT .............................................................................................................................................................................................................................. 60 

5.10.1 Ant script ................................................................................................................................................................................................................ 60 
5.11 FILE RELOCATION ............................................................................................................................................................................................................. 61 

5.11.1 Relocation root directory ....................................................................................................................................................................................... 61 
5.11.2 Filename format ..................................................................................................................................................................................................... 62 
5.11.3 Copy files when relocating ..................................................................................................................................................................................... 62 

6 TROUBLESHOOTING ......................................................................................................................................................................................................... 63 

6.1 LOG FILE .......................................................................................................................................................................................................................... 63 
6.2 SETTINGS FILE .................................................................................................................................................................................................................. 63 

7 ACKNOWLEDGEMENTS .................................................................................................................................................................................................... 64 



  T R A I N S P O T T E R  U S E R  G U I D E  

    

- 6 - 

 



  T R A I N S P O T T E R  U S E R  G U I D E  

    

- 7 - 

1 Installing Trainspotter 

1.1 Windows 

1.1.1 Prerequisites 

 Java 1.5, preferably 1.6 

 Traktor 3.4.1, Traktor 1.1.2, Traktor 1.2.1 or above 

1.1.2 Install steps 

1. Double click Trainspotter1-win32-install-1.54.jar (or click Trainspotter1-win64-install-1.54.jar for 64 bit versions of 
Windows) 
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2. Select a path to install Trainspotter 

3. Click next 
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4. After the installation has completed click next 
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5. Select your shortcut options for Trainspotter 

6. Click next 
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7. Click Done 

8. Trainspotter can now be run from the Start->All Programs->Trainspotter1->Trainspotter1 or by running the .exe file in the 

install directory. 
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1.2 OS X 

1.2.1 Prerequisites 

 Java 1.5, preferably 1.6 

 Traktor 3.4.1, Traktor 1.1.2, Traktor 1.2.1 or Traktor 1.2.2 

1.2.2 Install Steps 

1. Double click Trainspotter1-macos-<version>-install.jar 
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2. Click Next 
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3. Select the installation path and click Next 
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4. Click Next 
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5. Click Done 

6. Trainspotter can now be run by double-clicking /Applications/Trainspotter/Trainspotter1 from Finder. 
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2 Running Trainspotter for the first time 
After the splash screen has closed Trainspotter opens its Preferences dialog: 
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 Trainspotter makes an educated guess at where your Traktor collection.nml file and backup directory are located. If these 
don‟t reflect what you have installed then either manually correct them or click the “Browse” button to find them. As long as 

these top three settings are correct you can click OK and Trainspotter will load 

 At the bottom of this screen is the “Fields to update” setting. When updating your collection from Discogs, the fields in the 
list to the left will be updated. If you want to preserve some of your fields in your collection (such as GENRE), transfer then 
to right hand list box by selecting the field and clicking “Remove”. The corresponding tag values will be written to your audio 

files if the “Write tag values to audio files” option is set. 

 For details of the rest of the settings in the preferences see Preferences Reference. 

 Click OK and Trainspotter starts. 
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3 The Trainspotter User Interface 

3.1 The Toolbar 

3.1.1 Search Mode 

Selecting Search Mode instructs Trainspotter to take you to the Discogs Browser tab to help you search for the selected track in 
the Discogs database. Tracks can be selected for searching by clicking on tracks in the Collection tab or double clicking a track 

in the Playlist Viewer in the Playlists tab. 

3.1.2 Tag Mode 

Selecting Tag Mode instructs Trainspotter to take you to the Custom Tagging tab when selecting tracks, this will allow you to 

manually update the track fields and insert custom tag string.  

Tracks can be selected for searching by clicking on tracks in the Collection tab or double clicking a track in the Playlist Viewer in 

the Playlists tab. 

3.1.3 Playlist mode 

Selecting Playlist Mode and clicking a track in the Collection tab will start playing the selected track (if the “Automatically play 
track when tagging” preference is set in the “Custom Tagging” preference page). This allows you to quickly preview tracks 
before right clicking the track and selecting “Add to Playlists”. Note that you need to have selected one or more playlists in the 

Playlists tab beforehand. 

3.1.4 Group By 

The Group By drop down allows you to select the field by which tracks are grouped in the Collection tab. Trainspotter uses the 
first letter of the selected field, fields starting with a non-alphanumeric value are placed in the „-„ tab. Grouping by different field 
can speed up the tagging process as once you‟ve identified an artist/album/label in discogs you can use the Discogs browser‟s  

back and forward buttons to identify other releases. 
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3.1.5 Left/right Arrows 

Clicking on the left/right arrows will select the previous or next track in your collection and will take you to the Discogs Browser 
tab or Custom Tagging tab depending on which mode is selected. Clicking the second right arrow will select the next track in 

your collection without cover art. 

3.2 The Main Menu 

3.2.1 File Menu 

Open 

Opens an nml file to edit 

Save As 

Saves the current nml file to a different location 

Save 

Saves the current nml file 

Exit 

Quits Trainspotter 

3.2.2 Edit Menu 

Preferences 

Opens the Preferences dialog 

3.2.3 Tools Menu 

Encode Collection to Flac 

Opens the “Encode to Flac” tab. This allows you to encode all the wav files in your collection to the flac format. If cover 

art has been defined then this will be added to the resulting flac files. 

Encode Collection to MP3 
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Opens the “Encode to MP3” tab. This allows you to encode all the wav files in your collection to MP3. If cover art has 
been defined then this will be added to the resulting MP3 files. 

Detect Keys 

Opens the “Detect Keys” tab. This allows you to detect the keys of your tracks, updating your nml file and writing the key 

tags to your tracks. 

Run Script 

Executes an ant script across your collection or playlist. 

Relocate Files in Collection 

3.3 Moves or copies your audio files according to the file naming 
settings defined the preferences (see Script 

3.3.1 Ant script 

The path to an ant script to execute on the collection. 

Trainspotter sends and receives track information using properties. The following table shows the names of the properties that 
are set so that your ant script can read them. If your script sets a property in the “Output property” column, your collection will 
be updated with the new value. 

Input property NML mapping Output property 

album.title The TITLE attribute from the ALBUM element output.album.title 

artist The ARTIST attribute from the ENTRY element output.artist 

bpm The BPM attribute from the TEMPO element output.bpm 

catalog.number The CATALOG_NO attribute from the INFO element output.catalog.number 



  T R A I N S P O T T E R  U S E R  G U I D E  

    

- 24 - 

comment The COMMENT attribute from the INFO element output.comment 

comments2 The RATING attribute from the INFO element output.comments2 

directory The DIRECTORY attribute from the ENTRY element output.directory 

file The full path of the audio file output.file 

extension The audio file extension  

genre The GENRE attribute from the INFO element output.genre 

import.date The IMPORT_DATE attribute from the INFO element output.import.date 

key The KEY attribute from the INFO element output.key 

label The LABEL attribute from the INFO element output.label 

lyrics The LYRICS attribute from the INFO element output.lyrics 

mix The MIX attribute from the INFO element output.mix 

producer The PRODUCER attribute from the INFO element output.producer 

ranking The RANKING attribute from the INFO element output.ranking 

rating The RATING attribute from the INFO element output.rating 

release.date The RELEASE_DATE attribute from the INFO element output.release.date 

remixer The REMIXER attribute from the INFO element output.remixer 

title The TITLE attribute from the ENTRY element output.title 
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track.number The TRACK attribute from the ALBUM element output.track.number 

xml The XML fragment of the entry  

 

  File relocation) 

3.3.2 Help Menu 

Manual 

Opens up a browser showing you the latest Trainspotter manual. 

 
Check for Updates 

Checks the tspotter.net website to see if there is a newer version of Trainspotter to download.  

 
Donate 

This opens a browser to a page where you can donate to this project. If you donate you’ll get a license which will remove 
the nagging dialogs and give you enhanced functionality. 

User Forum 

Opens up the user forum in a browser. 

 

Install License 

This allows you to specify the license file you want to use. 

License Info 

Displays the current license information 
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3.4 The collection tab 

3.4.1 Data display 
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The collection tab shows the contents of your Traktor collection. The name of the tab is the name of your collection nml file. If 
the collection has been edited and needs saving, an asterisk will appear to the left of the name. 

You can order the tracks by clicking on the column heading. 

You can rearrange the order of the headings by dragging and dropping them. 

Moving your mouse over a cover picture will pop up a box showing all the stored album art for the track. 

If there is no cover art for the track, a question mark icon will be displayed. If no art is displayed, this means that Trainspotter 

has run out of cache space to cache the image. To see the cover art, move the mouse over space in the image column 

3.4.2 Hotkeys 

Moving between tabs in the collection can be done by using the ALT+LEFT and ALT+RIGHT. 

To add the currently selected track to the selected playlists press INSERT. 

3.4.3 Context Menu 

3.4.3.1 Edit 

Right click on the data field you want to edit and then click Edit to edit it. Hit enter to finish. 

3.4.3.2 Add to Playlists 

Selecting this item adds the selected track to the playlists selected in the Playlists tab 

3.4.3.3 Show/Hide Columns 

You can show or hide columns by right clicking on the table and selecting “Show/hide columns” and then the name of the 

column you want to show or hide. 

3.4.3.4 Search 

Right click on the track you want to search for, select “Search” and then select the field that you want to search for in Discogs. 

Trainspotter will take you to the Discogs Browser page and search Discogs for the selected field value. 
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3.4.4 Drag and Drop 

You can drag and drop a track from your collection in to Traktor or other application, just as you would drag a track from your 
file system. 

Dragging tracks and folders in to Trainspotter will add the contained audio files to your collection and name them according to 

your defined filenaming structure (see Track Import) 
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3.5 Discogs Browser Tab 

 

3.5.1 Search Results 

The Search Results list is populated when a track is selected in “Search Mode” or when a new track is selected in the collection 

(either explicitly or when Trainspotter automatically selects the next untagged track). 
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Trainspotter will use information from your collection to query discogs, however, you can highlight a portion of the track path 
(displayed in the heading) and click “Search selected text” to query discogs for a particular string. Alternatively, if your files 
follow a uniform naming convention you can configure a regular expression in the preferences to extract tag values from the 

filename which will give you more accurate results and less clicking around. 

The first column shows the cover art of the matching release or a question mark if no cover art is available. The second column 

gives a description of the release. 

The number of search results that are returned is configured in the Searching page in the Preferences. 

You can alter the sizes of the Search Results window and the browser window by dragging the dividing line between the two 

panes. 

Clicking a search result will set the Discogs browser to the release page. Trainspotter will then try and match the current track 

with one in the release (see 5.4.3). If you have defined a regular expression (see 5.4.3) then the track name extracted using 
the regular expression will be used. 

3.5.2 Hotkeys 

To select the next/previous track in your collection press ALT+LEFT or ALT+RIGHT and Trainspotter will update the Search 

Results accordingly 

3.5.3 Search Update from Discogs 

This pane allows you to browse the discogs web site and identify matching releases to the track you are searching for. When 

you land on a “release” page Trainspotter will automatically populate the matching tracks dropdown. 

3.5.3.1 Back/forward buttons 

These control the browser window beneath and browse back or forwards. 

3.5.3.2 Search buttons 

If the search results don‟t contain the correct release, click “Artist”, “Album”, “Label”, “Filename” or “Collection” to search 

Discogs for potential matches. 
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The “Collection” search will search from within your Discogs Collection if you have a discogs account. 

The “Filename” search will search using the filename of the track on your hard drive. 

3.5.3.3 Select matching track drop down 

This is populated when Trainspotter detects that you are on a Discogs page containing details of a release, or after you have 

clicked a release in the Search Results. 

3.5.3.4 Record button 

After a track has been selected from the matching track drop down, the “Record” button is enabled. Clicking this button creates 

a blank WAV file using your filename format (see 5.5.2) and opens it up in your audio editor (see 5.5.4). 

3.5.3.5 Rip Button 

After a release has been selected, the “Rip” button is enabled. Clicking this button opens a dialog box to select the tracks that 
you want to rip. If the release span more than one CD you can tell Trainspotter which track is the first track on the CD in your 

drive so the tracks match up. After selecting the tracks Trainspotter runs your configured CD ripping program (see 5.5.5). 

3.5.3.6 Update Fields button 

After a track has been selected from the matching track drop down, the “Update Fields” button is enabled. Clicking this button 
will update the fields in your Traktor collection with information from Discogs. You can be selective about the fields that you 
want Trainspotter to update by configuring the “Fields to update” preference (see 5.1.9). 

Trainspotter will also try and identify other tracks in your collection from the same release and automatically update these 
tracks also. Trainspotter will try and match the tracks titles using the preferences in the Searching preference page. It will also 

try and match track numbers. 
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3.6 Custom Tagging Tab 

 

This tab allows you to edit the standard Traktor fields for the selected release, apply cover art and add custom tags to the 
Comments2 field in your Traktor collection. By default Trainspotter will open up your music player and play the track. This can 

be turned off by going to the Custom tag configuration page and unchecking Automatically play track when tagging. 
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3.6.1 Custom Tags 

The top two lines of fields are those which you have defined in Custom tag configuration. The selected text in these fields is 
aggregated in to the Comments2 field if the track in your Traktor collection. The “Other Info” is free text that you can add, such 

as tracks that mix well with the current track. 

3.6.2 Standard Tags 

These are just editors for the standard fields you can set in a track in your Traktor collection. 

3.6.3 Cover 

This is where you can define the images that are displayed in the collection tab and which image to include in your FLAC/MP3 
file of the track. Trainspotter uses the Comments field to store the paths of the images relative to the collection.nml. When 

encoding tracks to FLAC/MP3, only the first image is encoded in to the FLAC/MP3 file as cover art. 

Trainspotter will also update the embedded images after you have encoded the file. 

3.6.3.1 Paste 

Clicking the Paste button pastes image data from your clipboard as cover art for the release, also updating the embedded cover 

art. 

3.6.3.2 Browse 

Click the Browse button allows you to select an image from your file system as cover art for the release. 

3.6.3.3 Download 

Clicking this button opens up a browser to Google images to search for the cover art of the track. You can customise the search 

parameters by using the Additional Google image search parameters setting. 

3.6.3.4 Apply to album 

Clicking this button applies the cover art on this track to all tracks on the album. 
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3.6.3.5 Delete 

Clicking the red X button next to an image will remove the image from the track. 

3.6.4 Hotkeys 

Press the Tab key to move to the next tag to update, or SHIFT+Tab to move to the previous tag. 

When setting the Ranking use the LEFT/RIGHT arrow keys for fine adjustment, and use CONTROL+LEFT/RIGHT to move the 

ranking in steps of 20%. 

To select the next/previous track in your collection press ALT+LEFT or ALT+RIGHT and Trainspotter will update the data 
accordingly. 
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3.7 Playlists Tab 

 

This tab allows you manage your Traktor playlists and create dynamic query-based playlists. 

3.7.1 Playlists Tree 

The playlists tree to the left allows you to navigate your Traktor playlists. Regular Traktor playlists are shown with a “file” icon, 

dynamical playlists are shown with a “play” icon. Right clicking a node in the tree will brings up the following menu options: 
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3.7.1.1 New Dynamic Playlist 

Allows you to create a playlist whose contents are based on a query of your collection. When selected the following dialog 

appears: 

 

Playlist Name 

Enter a description of the playlist query 
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Tracks 

This allows you to select which tracks will be queried to generate the playlist. By default, the “Select all tracks from collection” 
is enabled, so the query will check all the tracks in your collection. Unchecking this option allows you to select which playlists 

and playlist folders to get tracks from for the query. 

Selecting playlists and playlist folders to exclude removes any tracks contained in those playlists from the query source. 

Match 

This dropdown allows you to specify whether tracks must satisfy all rules or any of the rules. 

Rules 

This area allows you to add rules to your query.  

Sorting 

This allows you to specify how the resulting playlist will be ordered 

Use rules/XQuery 

For users familiar with the XQuery language, this allows you to specify your own custom XQuery. Note that the query must 

return ENTRY objects to work. See www.tspotter.net for XQuery examples that produce playlists or ask on the user forum. 

3.7.1.2 New Playlist 

This option creates a new regular Traktor playlist. 

3.7.1.3 Copy Playlist 

This option creates a duplicate playlist. 

http://www.tspotter.net/
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3.7.1.4 Edit 

This option is only highlighted for dynamic playlists and brings up the same dialog as “New Dynamic Playlist”. This option can 

also be performed by double-clicking a dynamic playlist. 

3.7.1.5 Delete 

Deletes the playlist 

3.7.2 Playlist Viewer 

The area to the right of the Playlist Tree is the Playlist Viewer. This will show you the contents of the playlists selected in the 

Playlist Tree. 

Tracks can be selected and dragged and dropped to Traktor. Use CONTROL+A to select all the tracks in the playlist. 

Double clicking on a track in the playlist viewer will find your track in your collection and invoke the search, tag or playlist 

functions, depending on what mode is selected (see 3.1). 



  T R A I N S P O T T E R  U S E R  G U I D E  

    

- 40 - 

3.8 Batch processing tabs 

 

The batch processing tabs for items in the Tools menu all allow you to pick from either your entire collection or a playlist. 
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The bottom of the tab shows the progress and output of the tasks being performed. This will vary depending on the tasks being 
performed. 

The “Total progress” bar tells you how far through your collection or playlist you are, and if you move your mouse over the bar, 

the tooltip will tell you when it estimates the batch processing will finish. 

The Start and Stop buttons control the execution of the tasks. The Stop button will stop processing after the current threads 

have finished executing. 

The number of processing threads allows you to process more than one item at once which speeds up processing time, 

however, more threads doesn‟t always decrease the processing time as your hard drive can become a bottleneck. It‟s 

recommended that you leave this set this to no more than the number of processing cores in your machine. 
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4 Using Trainspotter 

4.1 Tagging your Traktor Collection from Discogs 
This section describes the steps involved in tagging your Traktor collection using information from Discogs. 

4.1.1 Searching for a matching release 

When you select a track in on the collection tab in Search Mode, Trainspotter will use the available information stored in your 
Traktor collection to query Discogs and display matches in the Search Results window. See the preference setting Maximum 

number of search results to retrieve from Discogs 

Sometimes the displayed search results won‟t contain any releases or won‟t contain the exact release that you have. This 

doesn‟t necessarily mean that the track isn‟t listed in Discogs, but you‟ll have to do some additional digging to find the release. 

To help you find releases in Discogs there are four search buttons (Artist, Album, Label and Collection) that you can use to take 

you to pages in Discogs where you may find the release you‟re looking for. 

Alternatively, you can highlight a portion of the filename to use to search discogs.  

If you have already registered with Discogs and have put all your releases in your Discogs collection, then you can use the 
“Collection” button to search your Discogs collection. 

4.1.2 Selecting a matching release 

If your release appears in the Search Results window, select it, and the browser window beneath will take you to the release 

page in Discogs. Trainspotter will automatically do this for you if only one release appears in the search results. 

Once the browser window is showing a “release” page in Discogs, you will be able to select the track from the release that you 

were originally searching for. Trainspotter will help you out here by trying to guess which track by comparing the name of the 

track in your Traktor collection with the ones in the release, and also by using the Track Number of the track if present. 

See the preference setting Maximum number of characters that can be different before two track names are considered 

different 
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4.1.3 Updating your Traktor collection 

Once you have selected (or Trainspotter has selected for you) the matching track, you can click “Update Fields”. This will 
update the entry in your Traktor collection with data held in Discogs. If Trainspotter detects that there are other tracks in your 

Traktor collection that are also on the release, Trainspotter will also update these tracks also. Depending on whether the track 

names match, Trainspotter may ask you to confirm that track in your Traktor collection matches the one in the Discogs release. 

After all the tracks in the release have been updated Trainspotter will automatically select the next track in your Traktor 

collection to search for. 

Use the Add recorded/updated tracks to discogs collection preference setting to add your identified release to your Discogs 
collection. 

4.1.4 How Trainspotter Handles Cover Art 

4.1.5 When updating a track, Trainspotter will download cover art to the “images” 
collection.nml resides. It then inserts relative links to the images in your chosen 
field (see Apply album art to all tracks in release 

When you click the “Download” button in the custom tagging page, if this preference is set, the image that you select will 

automatically be applied to all track in the release in your collection. 

Field to use store image paths) in your entry in your Traktor collection. It will also put a copy of the first image in the folder 

that the track itself resides, called “folder.jpg”, if the corresponding preference is set (see 5.1.6). 

If the file is FLAC or MP3 then Trainspotter will also update the embedded cover art in the file. 

If you don‟t want Trainspotter to update your Comments field, then remove it from the “Fields to update” preference (see 

5.1.9). 

4.2 Recording tracks 

4.2.1 Prerequisites 

1. Click Edit->Preferences from the menu. 
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2. Click on the Recording item on the left hand pane 

3. Verify that all the settings are correct for your machine, see Recording. 

4.2.2 Selecting a track to record 

1. To select a track to record you first need to browse to a release page in the browser on the Discogs Browser page. 

2. Once on a release page use the “Select Matching Track” drop down to select the track you want to record. 

3. Click the record button. 

Your audio editor program should start and it should load a blank WAV file created using the Filename Format you 

specified and the WAV file audio format you specified. The track will also have been added to you Traktor collection. 

4. Record the track as normal. 

4.3 Ripping tracks 

4.3.1 Prerequisites 

1. You need to have installed third party software for extracting digital audio from CDs.  

2. Click Edit->Preferences from the menu. 

3. Click on the Recording item on the left hand pane 

4. Verify that all the settings are correct for your ripping software, see Recording. 

4.3.2 Ripping a release 

5. Put the CD in your drive 

6. Open the Discogs tab in Trainspotter 
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7. Browse to a “release” page in discogs matching your CD 

8. Click the Rip button 

9. Select the tracks you want to rip 

10. Click OK 

11. Ripping progress is shown in the status bar in Trainspotter. When ripping is complete the wav files are added to you 

collection 

4.4 Encoding tracks to FLAC and MP3 

4.4.1 Why? 

Although WAV files allow you to store some image information inside them, this is not read by Traktor Pro. Nor does Traktor Pro 
read the folder.jpg file from the tracks directory to use as cover art. Traktor Pro stores cover art in a proprietary format that 

makes it impossible for third party applications to programmatically alter. The only way of modifying it is through Traktor Pro 
itself. 

FLAC is a lossless audio file format that can store cover art inside it, and is able to read by Traktor Pro. Hence by converting 
your WAV files to FLAC, you‟ll be able to view the cover art in Traktor Pro. 

If you choose to encode tracks to MP3 the cover art will also be available, but there will be some loss in audio quality (the 

amount of which will depend on your encoder settings). 

4.4.2 Prerequisites 

1. Click Edit->Preferences from the menu. 

2. Click on the Encoding item on the left hand pane 

3. Verify that all the settings are correct for your machine, see Encoding. 
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4.4.3 Starting and Stopping encoding 

1. Click Tools->Encode Collection to FLAC/MP3 

2. The Encode to FLAC/MP3 tab appears 

3. Click Start Encoding 

Trainspotter will now scan your Traktor collection for any WAV files and encode them to FLAC or MP3 and embedding the 

first image as the cover art. The window shows the current encoding progress. 

4. You can stop the encoding at any time by pressing the Stop Encoding button. This will instruct Trainspotter to stop 
encoding after the current track has been encoded. 

Trainspotter will save your collection after it has encoded each track. 

4.5 Applying custom tags to tracks 

4.5.1 Why? 

Traktor allows you to search your entire collection to find matching tracks given various search terms. If you have a large 
collection finding the right track to play next can be quite a challenge. Traktor gives you to a Comments2 field in which you can 
write free text about the track. The problem is, if you want to use this as a method of categorising your tracks it will take you a 

very long time indeed to type descriptions in to the Comments2 fields in all your tracks, and also you may not spell everything 
correctly or describe things consistently, the result is that when you go and search in Traktor, not all the tracks you hoped 

would appear show up in your search results. 

Trainspotter allows you to define a set of custom tags that you can embed in the Comments2 field, so you can describe and 

categorise tracks in a way that makes sense to you. 

For example, you could define a set of tags to use indicating the time of night that a track might be played at, time_early, 
time_middle, time_primetime, time_end. You could then apply these tags to your tracks and search for them in Traktor. 

You can also use these to describe things like: 
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 Instruments used 

 Rhythm type 

 Bassline type 

 Mood 

 Energy level 

 

4.6 Creating Dynamic Playlists 

4.6.1 Why? 

Currently Traktor only produces lists of tracks from a certain genre/label/artist/release. It‟s not possible to create playlists that 
represent a query of your whole collection. iTunes allows you to define smart playlists but the data that is available is only from 
the file itself and not from your collection. So, for example, iTunes would not be able to give you a smart playlist of all your 

beatgridded tracks or all the tracks that had loops defined. 

4.6.2 Using Dynamic Playlists 

One good use of dynamic playlists is to define them based on the custom tag values you have defined. The field that you need 

to use is the “RATING” field as this is the field that stored the Comments2 data. 

See www.tspotter.net for examples of dynamic playlists. 

4.7 Detecting Keys 

4.7.1 Why 

Tracks that have the same key or a compatible key generally sound better mixed together. Knowing what key the playing track 

is in can help select a song in a compatible key or tell you by how many semitones you need to raise or lower your next track. 

http://www.tspotter.net/
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4.7.2 Using Key Detection 

First, make sure you have set your preferences on the “Key detection” page of the preferences. This allows you to specify what 
format you write your keys in, how Trainspotter colours keyed tracks in the collection browser, and to specify an external 

program to decode your non WAV, FLAC and MP3 audio files to WAV format (the key detection in Trainspotter requires audio 

files either in WAV format or to be able to be decoded to WAV format). 

Once your preferences are set, click “Tools->Key Detection” from the menu. 

Next select either all tracks or a playlist of tracks to detect the keys and click “Start”. 

Once you‟ve finished you can use the Dynamic Playlists to create a playlist for each key, or pair of compatible major and minor 

keys. 
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5 Preferences Reference 

5.1 File 

5.1.1 My collection.nml file 

The path to your collection.nml. Trainspotter will automatically load this file each time it starts. 

5.1.2 Periodically save a backup of your collection after updates have been performed 

With this setting enabled Trainspotter will save a backup of your collection as you are editing it. If you make a change to your 

collection and it‟s been over a minute since it saved a backup, then a new backup is created. 

5.1.3 My collection.nml backup directory 

The path to your Traktor backup directory. Trainspotter writes a file called collection.nml.bak to this directory as a running 
backup of your collection as displayed in Trainspotter. Should Trainspotter exit unexpectedly, you can use this file to continue 

from where you were last editing it. 

5.1.4 Default file open directory 

This is the directory that is opened when you click File->Open. 

5.1.5 Maximum number of images to store per track 

This limits the number of images downloaded from Discogs and also the number of images you can apply to a track in the 

Custom Tagging tab. 

5.1.6 Update folder album art 

Many applications will use a file called “folder.jpg” in a track‟s directory as the displayable cover art. Checking this item will 

copy the first image stored against the track to the “folder.jpg” file. 
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5.1.7 Update embedded art in mp3 and flac files 

When enabled and you click “update fields”, this will update mp3 and flac files to contain the cover art in the discogs release. 

If you are updating the cover art on the “custom tags” page, the images you select will also be embedded in the mp3 or flac file 
you are tagging. 

5.1.8 Apply album art to all tracks in release 

When you click the “Download” button in the custom tagging page, if this preference is set, the image that you select will 

automatically be applied to all track in the release in your collection. 

5.1.9 Field to use store image paths 

Trainspotter needs to use a field to store the relative image paths. By default, the comments field is used, but you may want to 

change this if you are already using comments to store other information. 

5.1.10 Fields to update 

The tracks in a Traktor collection contain many different fields. Some of these fields you may not want Trainspotter to change. 
The fields that you don‟t want Trainspotter to update should appear in the right hand list. You should include the field assigned 

to hold relative image paths. 

Check the “Write tag values to audio files” if you want the fields updated in you nml file to also be applied to your audio files. 

Currently the following tags are written: 

 Album title 

 Artist 

 Catalog Number 

 Comment 

 Genre 

 Key 

 Lyrics 

 Label 
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 Remixer 

 Track Title 

 Track Number 
Note that Trainspotter does not update any fields not mentioned in the list, such as Cue Points. 

5.1.11 Update Mix Fields from History 

With this option enabled, Trainspotter will scan through your Traktor history folder and update the MIX field for tracks in your 

collection with the names of tracks that a particular song has followed. 

The result of this is that when you run Traktor you can search for tracks that you have mixed with the current track simply by 
searching Mix = <current artist> <current track>. This is useful if you know that you‟ve previously found a good track to mix 

with the current one, but can‟t remember what it was. 

5.1.12 Check for Trainspotter Updates on Startup 

This option will automatically inform you if there is a later version of Trainspotter to download from the website. 

5.2 Track Import 
The settings on this page determine how filenames and paths are turned in to tag information. Users of the Beatport Downloader can set 

their folder structure, file naming and separator to the same setting as in the Beatport Downloader application.  

5.2.1 Folder Structure 

Flat (Beatport Option 1) 

Trainspotter will ignore the track‟s parent folder and just extract information from the filename. 

Artist/[Catalog Number] Release/ (Beatport Option 2) 

Trainspotter will assume that the folder structure is formatted the same as Beatport Option 2 and extract the fields 

accordingly 

Label/[Catalog Number] Release/ (Beatport Option  3) 
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Trainspotter will assume that the folder structure is formatted the same as Beatport Option 3 and extract the fields 
accordingly 

Artist/Release 

Trainspotter will assume that the folder structure is formatted and extract the fields accordingly 

5.2.2 File Naming 

TrackID-TrackName-MixName (Beatport Option 1) 

Trainspotter will assume that the filename is formatted and extract the fields accordingly. The TrackID field is ignored and 
not stored. 

Artist-Track-MixName (Beatport Option 2) 

Trainspotter will assume that the filename is formatted and extract the fields accordingly 

Label-Track-MixName (Beatport Option 3) 

Trainspotter will assume that the filename is formatted and extract the fields accordingly 

Artist – Track 

Trainspotter will assume that the filename is formatted and extract the fields accordingly 

5.2.3 Preferred Separator 

Set this character to the one used to separate fields in the filename 

5.3 Look and Feel 

5.3.1 Window width 

The width of the Trainspotter window when opened. 
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5.3.2 Window height 

The height of the Trainspotter window when opened. 

5.3.3 Open window maximized 

Opens Trainspotter maximized. 

5.3.4 Run on top 

Forces Trainspotter to always be the topmost window. 

5.3.5 Default grouping column 

The value of the Group By dropdown when Trainspotter starts. 

5.3.6 Show the following fields in your collection 

A list of the track fields to display in the collection tab. 

5.3.7 Height of rows in collection browser 

Use this to adjust the row height, this will clip the bottom of the cover art off at lower settings, similar to the browser in Traktor 
Pro. The effect of changing this setting will only be seen the next time you start Trainspotter. 

5.3.8 Display embedded cover art in collection browser 

When enabled this tell Trainspotter to read the embedded cover art from flac and mp3 files. If you have a large collection this 

will increase the startup time of Trainpotter. 

5.3.9 Maximum number of cover art images to cache 

When Trainspotter loads your collection it reads the cover art to display in the collection browser. Depending on the size of your 
collection and the amount of images included in the tracks this can mount up to be a large amount of data. This setting limits 

the amount of images that Trainspotter loads. This means a tradeoff between the startup time and the number of images 
displayed in the browser. 
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If you have a large collection, there is a risk that your machine will run out of memory or file handles when starting up. Should 
this happen you will need to manually edit the Trainspotter.properties file (see ) and set the image.cache.size to a lower value 

and restart.  

5.3.10 Key Colours 

The “Start Hue” option allows you to set the colours of the keys as they are shown in the circle of fifths. The value chosen for 

the Start Hue is the colour that will be applied to E Major and C#/Db Minor. 0/360 is red, 60 is yellow, 120 is green, 180 is 

cyan, 240 is blue, 300 is purple.  

5.4 Searching 

5.4.1 Maximum number of search results to retrieve from Discogs 

Limits the number of search results returned. Note that Discogs allows only 2000 queries per day per IP address, and 

increasing the number of search results retrieved will use up those queries quicker, and also take longer to display. 

5.4.2 Add recorded/updated tracks to discogs collection 

When you click either “Update Fields” or “Record” this setting will add the release displayed in the Discogs Browser tab to your 

Discogs collection, as if you had clicked “Add to Collection” on that page. 

5.4.3 Match filenames to regular expression 

Here you can supply a regular expression to help Trainspotter extract tag values from your audio filenames before it queries 
Discogs. If you‟re not familiar with regular expressions post your filename format to the user forum and we‟ll help you out. 

5.4.4 The regular expression group to use for (artist/catalog number/track/label) 

Once Trainspotter has matched the filename to the regular expression, fields can be assigned to the matching groups (i.e. the 

characters matched between the brackets) and used to search discogs and match track names. 

If you are using a regular expression that only matches a selection of the tags, set the group numbers for the unused tags to 

number greater than number of groups you are capturing. 
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For example, say your filename looked like: 

The Beatles – Yesterday.wav 

And your regular expression was: 

.+ ([^-]+)-([^-]\.)\.wav$ 

Then you would set the artist group number to be 1, the track name group number to be 2, and all others to be group number 

3. 

5.4.5 Maximum number of characters that can be different before two track names are 
considered different 

Sometimes the track name that you have in your collection doesn‟t match the one held in Discogs for the same release. There 

are many causes for this including typos, different punctuation and different capitalisation. 

When Trainspotter tries to match a track name in your Traktor collection to a track name in a release in Discogs it ignores case 

and punctuation and also allows for a limited number of characters to be different before it identifies it as a match. 

For example if the setting is 3 characters: 

Traktor Track Name Discogs Track Name Match 

hello world (the remix) Hello World (The Remix) Yes (case is ignored) 

hello world the remix Hello World (The Remix) Yes (case and punctuation 

ignored) 

hello world (88 remix) Hello World („88 mix) Yes (remix and mix differ 

by less than or equal to 3 

characters) 

hello world (remix) Hello World (The Remix) Yes (track titles differ by 
less than or equal to 3 
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characters 

hello world Hello World (The Remix) No (track titles too 

different) 

 

This setting is used in two places: 

 when Trainspotter finds only one matching release for a track it will try and automatically select that track from the 

dropdown 

 when Trainspotter is updating fields on other tracks on the same release in your Traktor collection it will use this algorithm. 

If Trainspotter doesn‟t find a match here then it will prompt you to select a matching track from the dropdown.  

5.4.6 Additional Google image search parameters 

Google images allows you to refine your search by providing additional parameters on the query string. If you open up a 
browser and browse to google images, each time you refine you search parameters, different parameters and values appear 
after the question mark in the URL. The default setting, imgsz=qsvga, corresponds to images “larger than 400x300”. Other 

setting you might want to use are: 

 imgsz=vga - “larger than 640x480” 

 imgsz=s – “small” 

 imgsz=m – “medium” 

 imgsz=l – “large” 

5.5 Recording 

5.5.1 Recordings directory 

The directory where Trainspotter will write blank audio files when you click “Record”. 
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5.5.2 Filename format 

The filename format of the blank audio files created when you click “Record”. Note that the filename format can contain 
slashes, this allows you to specify a directory structure to store your recordings in. 

This filename format is also used when encoding files to MP3 or FLAC. 

5.5.3 Recorded audio format 

The sample rate and bit depth of audio files that are created when you click “Record”. 

5.5.4 Audio file editor command 

The command line that Trainspotter invokes when you click “Record”. Trainspotter will append to this line the name of the blank 

audio file it has just created. Construct this command line so that your audio editor opens the file for editing. 

5.5.5 Rip Command 

The path to the program that Trainspotter runs for each track you see when you press the “Rip” button. 

5.5.6 Parameters to Rip Command 

The parameters that are supplied to the “Rip Command”.  

%n will inline a two character track index, e.g. 01 

%N will inline a single character track index 

%f will inline the filename (in the format specified by “Filename format”) 

5.5.7 Rip command outputs to standard error 

In order to show the progress of the ripping operation, Trainspotter can read either the standard output or standard error 
streams. If the wrong one is selected the ripping process will hang. If this happens, change this preference and try again. 
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5.6 Encoding 

5.6.1 Path to FLAC encoder 

The path to your FLAC encoder executable in your filesystem. 

5.6.2 FLAC arguments 

The command line arguments to supply to FLAC. -0 gives the least compression, -10 the greatest 

5.6.3 FLAC output directory 

The directory where encoded audio files will be written. The Filename Format parameter also applies to encoded audio files. 

5.6.4 Path to LAME encoder 

The path to your LAME encoder executable in your filesystem. 

5.6.5 LAME arguments 

The command line arguments to supply to LAME – see the LAME documentation for details. 

5.6.6 LAME output directory 

The directory where encoded audio files will be written. The Filename Format parameter also applies to encoded audio files. 

5.6.7 Continue processing when error occurs 

If enabled this will halt encoding when the command line encoder returns an error. 
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5.7 Key detection 

5.7.1 Key Labels 

These allow you define what text gets written to your collection.nml and your audio file tags when Trainspotter has detected a 

key.  

5.7.2 Overwrite Existing Key Values 

By default Trainspotter will not attempt to detect a key for a track that already has a key value defined. However there may be 

cases where you want to overwrite existing values. 

5.7.3 Perform key detection as part of encoding tracks to MP3/FLAC 

When selected this will run the key detection process before encoding. This means that the key detection process will be quick 
as Trainspotter will not have to first decode the audio files to WAV. 

5.7.4 Perform key detection after ripping tracks from CD 

When selected this will run the key detection process after each track has been ripped. 

5.7.5 Path to LAME MP3 encoder 

The location of your lame executable if you want to detect keys of MP3s. 

5.7.6 Path to FLAC encoder 

The location of your lame executable if you want to detect keys of FLAC files 

5.7.7 Temporary directory to use for decoded MP3/flac files 

The default value for this setting is your system default temporary folder, however it may speed up decoding performance if 

you change this location to a folder on your fastest hard drive. 
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5.7.8 Path to audio decoder 

The location of a program used to decode an audio file format extension to WAV format. 

5.7.9 Arguments to audio decoder 

The required arguments to the program to complete the decoding. 

5.7.10 Extension to apply audio decoder to 

The audio file extension to run the decoder against. 

5.8 Custom tag configuration 

5.8.1 Type 

Whether the tag should be shown as a single select or multi select listbox. 

5.8.2 Name 

The name of the tag to be displayed in the Custom Tagging tab. 

5.8.3 Values 

A comma separated list of values that the tag can take. Note that each value should be unique across all tags and should not be 

a substring of any other tag value, otherwise Trainspotter may mark the value as selected in more than one tag. 

5.8.4 Automatically play track when tagging 

When selected, Trainspotter will invoke your system default audio playing application to play the track. 

5.9 Colours 
You can use these settings to change some of the user interface elements in Trainspotter. 
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5.10 Script 

5.10.1 Ant script 

The path to an ant script to execute on the collection. 

Trainspotter sends and receives track information using properties. The following table shows the names of the properties that 

are set so that your ant script can read them. If your script sets a property in the “Output property” column, your collection will 

be updated with the new value. 

Input property NML mapping Output property 

album.title The TITLE attribute from the ALBUM element output.album.title 

artist The ARTIST attribute from the ENTRY element output.artist 

bpm The BPM attribute from the TEMPO element output.bpm 

catalog.number The CATALOG_NO attribute from the INFO element output.catalog.number 

comment The COMMENT attribute from the INFO element output.comment 

comments2 The RATING attribute from the INFO element output.comments2 

directory The DIRECTORY attribute from the ENTRY element output.directory 

file The full path of the audio file output.file 

extension The audio file extension  

genre The GENRE attribute from the INFO element output.genre 

import.date The IMPORT_DATE attribute from the INFO element output.import.date 
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key The KEY attribute from the INFO element output.key 

label The LABEL attribute from the INFO element output.label 

lyrics The LYRICS attribute from the INFO element output.lyrics 

mix The MIX attribute from the INFO element output.mix 

producer The PRODUCER attribute from the INFO element output.producer 

ranking The RANKING attribute from the INFO element output.ranking 

rating The RATING attribute from the INFO element output.rating 

release.date The RELEASE_DATE attribute from the INFO element output.release.date 

remixer The REMIXER attribute from the INFO element output.remixer 

title The TITLE attribute from the ENTRY element output.title 

track.number The TRACK attribute from the ALBUM element output.track.number 

xml The XML fragment of the entry  

 

5.11   File relocation 

5.11.1 Relocation root directory 

Use this to select the base directory that files should be moved/copied to. 
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5.11.2 Filename format 

This is the setting that determines the directory and filename structure of your audio files. The text that you can put in here is 
the same format as in Filename format. 

5.11.3 Copy files when relocating 

By default audio files are copied, unchecking this setting will mean that files are moved. Note that if the files are on different 

drives or volumes and this setting is unchecked, the files will be removed from the source drive or volume. 
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6 Troubleshooting 

6.1 Log File 
On Windows XP Trainspotter logs to <user home directory>\My Documents\Trainspotter\trainspotter.log, e.g. 

C:\documents and settings\fred\My Documents\Trainspotter\trainspotter.log 

On Windows Vista and Windows 7 Trainspotter logs to <user home directory>\Documents\Trainspotter\trainspotter.log, 
e.g. C:\Users\fred\ Documents\Trainspotter\trainspotter.log 

On OSX Trainspotter logs to <user home directory>/Documents/Trainspotter/trainspotter.log, e.g. 

/Users/fred/Documents/Trainspotter/trainspotter.log 

The logging is controlled by a log4j.properties file in the Trainspotter install directory, e.g. c:\program 
files\Trainspoterr\lg4j.properties on Windows, or /Applications/Trainspotter/Trainspotter.app/Contents/Resources/Java 

on OS X 

6.2 Settings file 
Trainspotter reads its settings from a file called Trainspotter.properties which is located in the same directory as the log file. 

If you find that Trainspotter no longer starts up fully it may be necessary to edit this file to change one of the settings back. If 
you delete the properties file, a new one is created and you are presented with the preferences dialog with the default setti ngs. 

If your settings are not being preserved from one session to the next, check that your Trainspotter.properties file is writable by 

the user running Trainspotter. 
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7 Acknowledgements 
Trainspotter uses the following third party libraries: 

 Apache ant - http://ant.apache.org - under Apache License 2.0 (http://www.apache.org/licenses/LICENSE-2.0) 

 Apache Commons - http://commons.apache.org/ - Codec, Collections, HttpClient, IO, Lang, Logging - under Apache License 

2.0 (http://www.apache.org/licenses/LICENSE-2.0) 

 Apache log4j - http://logging.apache.org/log4j/1.2/index.html - under Apache License 2.0 

(http://www.apache.org/licenses/LICENSE-2.0) 

 Apache Xalan - http://xalan.apache.org/ - under Apache License 2.0 (http://www.apache.org/licenses/LICENSE-2.0) 

 Apache XMLbeans - http://xmlbeans.apache.org/sourceAndBinaries/index.html - under Apache License 2.0 

(http://www.apache.org/licenses/LICENSE-2.0) 

 SWT - http://www.eclipse.org/swt/ - under Eclipse Public License v1.0 

 Eclipse - http://www.eclipse.org/downloads/ Eclipse Public License v1.0 - commands, runtime, equinox common, jface, osgi, 

ui forms, ui workbench 

 Xerces - http://archive.apache.org/dist/xml/xerces-j/ - under Apache License 2.0 

(http://www.apache.org/licenses/LICENSE-2.0) 

 YUI - Copyright (c) 2008, Yahoo! Inc. 

 The Saxon XSLT and XQuery Processor from Saxonica Limited - http://www.saxonica.com/ See 

http://www.saxonica.com/documentation/conditions/contributors.html for a list of included third party components  

 This product includes the TrueLicense Library Collection (TrueLicence) which has been developed by Schlichtherle IT 

Services (http://schlichtherle.de) and is covered by the Apache License, Version 2.0 

(http://www.apache.org/licenses/LICENSE-2.0). 

http://www.saxonica.com/
http://schlichtherle.de/
http://www.apache.org/licenses/LICENSE-2.0
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 This product includes modified example code published on Sun's Java web site at 
http://java.sun.com/developer/technicalArticles/GUI/swing/wizard/index.html. 

 JAudioTagger - http://www.jthink.net/jaudiotagger/ under the Lesser GPL - http://www.gnu.org/copyleft/lesser.html 

 Minim - http://code.compartmental.net/minim/distro/minim-2.0.2-full.zip - under the Lesser General Public License 
http://www.gnu.org/licenses/lgpl-3.0-standalone.html 

Trainspotter also integrates with the following: 

LAME - www.mp3dev.org 

FLAC - http://flac.sourceforge.net/ 

 

 

http://java.sun.com/developer/technicalArticles/GUI/swing/wizard/index.html
http://www.jthink.net/jaudiotagger/
http://www.gnu.org/copyleft/lesser.html
http://flac.sourceforge.net/
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